Understanding Part
Builder

Part Builder lets you create and modify pipe network parts that are available in

Autodesk® Civil 3D part catalogs.

This section describes the fundamental concepts involved with using Part Builder

and explores the user interface.
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Before You Begin

Part Builder is intended primarily for advanced AutoCAD Civil 3D users who are experienced with parametric
modeling design and with AutoCAD Civil 3D pipe network features.

WARNING Before using Part Builder to create or modify pipe network parts, it is important that you create and
save a backup copy of the AutoCAD Civil 3D pipe network part catalogs and support files. These files are installed
by default in the following location: C:\Documents and Settings\All Users\Application Data\Autodesk\C3D
2008\enu\Pipes Catalog. Create and save a backup copy of this folder and its contents, including all subfolders
and their corresponding content.

Individuals experienced with parametric modeling design, concepts, and techniques should be comfortable
making use of the full spectrum of features available through Part Builder. Individuals with little or no
experience with parametric modeling should be comfortable using the more basic Part Builder features, such
as adding or changing part sizes in existing part families. For more information, see Editing Part Family Sizes
(page 1047).

Part Builder Overview

With Part Builder, you can design and edit shapes for drawing content that represent real-world pipe network
parts, such as pipes, manholes, catch basins, and headwalls.

Each piece of content represents a part family, such as concrete pipe, ductile iron pipe, and concrete elliptical
culvert. Each part family contains a collection of part sizes within that part family. For example, within the
concrete pipe part family, there are a variety of pre-defined part sizes available for that part. Part Builder
enables you to create and modify part families as well as individual part sizes.

When you use Part Builder, you can build 2D models of pipe parts, and/or 3D models of structure parts, and
generate 2D drawing views of those parts to use in design layouts. The model you create is defined according
to the size, shape, and position of the features that make up the part. Parts are stored in a part catalog, such
as the US Imperial Pipe Catalog, and you can navigate to and select the part from within a catalog when
you want to add it to your layout.

Getting Started Catalog Screen
When you run Part Builder, the Getting Started Catalog Screen dialog box is displayed. From this dialog box,

you can choose to work with the pipe catalog or structure catalog and navigate through the categories within
that catalog.
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The icons on this dialog box let you perform several tasks. If you position your mouse over an icon, a tooltip
provides an explanation of the icon. Icons are activated based on what is selected in the catalog tree.

If you want to... then do this ...

select a chapter folder then click New Parametric Part. Enter a
E name and description for the new part on the New Part dialog
Create a box, and click OK. After doing this, the building environment is
new part opened for part creation.

select the part in the catalog tree, and click Modify Part Sizes.
The building environment is opened for modifying the part.
modify an

existing part size

after making changes to parts or to a catalog, click Catalog Regen

|'_'|E| to regenerate the entire pipe or structure part catalog.
regenerate

the catalog
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If you want to... then do this ...

after making changes to a catalog, click Catalog Test to verify

W | that the validation is successful.
test (valid-
ate) the catalog

click New Chapter and enter a name. You can add chapters to

|=_Ii the catalog or to another chapter.
add a new

chapter for a part

select the part and click Delete. The part is deleted from the

> catalog and is removed from the catalog tree.
delete a part

Parametric Building Environment

When you choose to create or modify a part, Part Builder opens a parametric building environment that
includes a variety of features:
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B Part browser. The part browser is displayed on the left side of the screen. It provides an organized view
into the features of the currently selected part. As you define your part, additional features are nested in
a hierarchy under the appropriate folder. In the browser, you can show more or less detail by expanding
or collapsing the folders.

B Modeling area (viewport). The modeling area (viewport) is displayed on the right side drawing space and
is designed to give you full view control over your part model. You can use the standard AutoCAD view
commands to change the direction in which you view your part model.

B Toolbar. The toolbar provides quick access to select Part Builder commands. Icons are available for saving
your part, saving an existing part as a new part, generating a preview image, validating your part, and
specifying part options.

B Status bar. The status bar, located at the bottom of the part browser, provides updated information about
part validation when you click the Validate icon on the toolbar. A description of the validation status is
provided. A details button provides a list of warnings and/or errors found in your model.
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B Feature-specific menus. Feature-specific menus are available by right-clicking a part feature in the browser
window. Options not available are shaded.

The part browser and the modeling area are resizable windows.

Understanding Parametric Parts

Parametric parts give you the flexibility to create pipe network parts that are dynamically sized according
to size parameters.

You define a parametric part by creating a 3D model of the part and assigning variables, or parameters, to
control its shape and size. Parameters are defined by individual values, lists of values, or calculated values
based on equations. When the pipe network part is placed in your drawing, you select specific part sizes and
the part is dynamically built to reflect the specified shape and size. Parametric parts enable you to create a
single 3D model for a part family that can be updated to represent multiple part sizes. You can define millions
of parts through a single model, depending on the number and type of parameters defined.

It is beneficial to create pipe network shapes as parametric parts for many reasons. Many of the shapes used
to represent pipe network components share the same geometric features; however, the features change in
size according to the design. For example, an 8-inch circular PVC pipe looks just like 10-inch PVC pipe
except for the pipe diameter. Similarly, you may have two headwall structures that are the same basic shape
but have different heights, widths, or both.

B Pipes: An 8-inch circular pipe looks the same as a 10-inch circular pipe, except for the size of the diameter.
By creating a parametric part, you can create a 2D cross section of a circular pipe and assign a parameter
for the pipe diameter that can change in size. When the pipe is placed in your drawing, the 3D pipe uses
this cross-sectional shape parametrically sized to match your part size selection. You specify which size
pipe you want and the appropriate diameter is dynamically built to match.

B Structures: A 38-inch concentric catch basin looks the same as a 48-inch catch basin, except for the height
and diameter. By creating a parametric part, you can create a 3D model of a catch basin structure and
assign parameters for the height and diameter that can change in size. When the catch basin is placed
in your drawing, you can specify the height and diameter, and the appropriate size catch basin structure
is dynamically built to match.

Key Terms

Understanding the following key terms will help as you begin using Part Builder.
constraint Controls the shape of a feature by establishing relationships between features in the model.

degree of freedom In part modeling, determines how a geometric object, such as a line, arc, or circle, can
change shape or size. For example, a circle has two degrees of freedom: center and radius. When these values
are fixed, degrees of freedom are said to be eliminated.

dimension Controls the size of a feature. When changed, the feature is resized. May be expressed as a
constant value, a value as part of a table, a calculated value, or a list of values.

domain Refers to the part category. There are only two domain types by default: pipes and structures. Each
domain type has a unique behavior in AutoCAD Civil 3D.

feature A building block of a pipe network part model. You combine features to create pipe network part
models.

model The part shape representing all possible sizes, and defined by parameters, geometry, dimensions, and
geometric constraints.
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parametric A solution method that uses the values of part parameters to dynamically size the part.
part size A specific set of values applied to the parametric model to define a single size.

work plane An infinite plane related to one or more features of the model. Work planes provide a defined
place in space from which to build the model.

Overview of Creating a Part

This section provides an overview of the steps involved with creating a part.

When you create a pipe network part, you define the features of the part and how they are associated with
one another. Each pipe network part represents a unique part family. You should analyze the pipe or structure
catalog hierarchy to determine the best place to add part families. It is also important to notice the
relationships between the different part sizes you want to create. The features you define in the model
determine the flexibility you have to create multiple part sizes. You should look at the entire part you want
to create, decide how to break it down into simple shapes, and determine the relationships to establish
between the different shapes.

Creating a part with Part Builder involves performing the following tasks in the order they are presented
below:

1 Specify the part configuration.

You work in the parametric building environment to create single pipe network parts. While you are
working in this environment, only one part can exist in a drawing. The individual drawings are associated
with a part catalog to build a library of parts. You specify the type and subtype of the part to establish
basic part behavior. For more information, see Part Configuration (page 1082).

2 Create a 2D or 3D model of the part.

During this phase of the process, you create models of 2D pipe parts, or 3D structure parts, and use

them to dynamically generate 2D views of the part. You build your part from features that are combined

to define the part. The model is defined according to the size, shape, and position of its features. You

can restrict how the features of the parts fit together. To better conceptualize the size and shape of the

part model, you define dimensions, constraints, and modifiers that determine how your part is built.

For more information, see Part Modeling (page 1084), Dimensions (page 1088), Constraints (page 1089), and
Modifiers (page 1092).

3 Generate a preview image and define the insertion position of the part.
Once you have finalized the model, you generate a preview image for the part by taking a snapshot of
the model. You also specify the placement position that you use to place the part in your drawing. For
more information, see Generating a Preview Image of a Part (page 1111) and Defining Part Insertion
Position (page 1112).

4 Validate and save the part.

Once you have finalized the model, you must validate and save the part. Validation checks the model
and detects any errors that make the part invalid. You must correct all errors in order to successfully
save the part and add it to a drawing. For more information, see Validating and Saving a Part (page 1113).

Part Configuration

Defining the part configuration is the first step in creating a part.

When the parametric building environment opens, the top folder in the part browser is the Part Configuration
folder. The part configuration defines the characteristics and behavior of the part according to the domain
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(pipe or structure), type, and subtype, and it is required to save the part. To ensure that the part can be
validated and saved correctly, you should define the part configuration before starting to model the part.
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The part configuration is defined once for a part family and remains constant for all part sizes. The following
components are required to define the part configuration:

Part Name You cannot change the part name of existing (default) parts. This is because part names for
existing parts are used in the filenames for the parts. You can, however, create a new name for a new part
using Save as.

Part Description Describes the part family. When you create and name a new part, you enter the description
in the New Part dialog box. By default, the description is the same as the part name unless a different
description is entered. For existing parts, the part description is predefined.

Part Domain Defines the family of parts. The two basic domains are pipes and structures. You cannot edit
the part domain in the part browser. The part domain is predefined based on the part catalog you selected
in the Getting Started dialog box of Part Builder. The part domain is selected from a list of predefined domains
for pipe networks (pipes and structures). In the illustration above, the part domain is Structure.

Part Type The part type defines certain behavior properties that are assigned to the part.

For pipes, the predefined part type is always “pipe”. A variety of pipe shapes may be available; for example
, Circular, egg-shaped, elliptical, and rectangular. However, they are all defined with same part type (pipe).

For structures, the predefined part types include general, inlet-outlet structures, and junction structures. As
previously mentioned, the part type defines certain application behavior properties that are associated with
the part. A general structure, for example, has a different set of application behavior properties than an
inlet-outlet structure, and so on. In the illustration above, the part type is Inlet-Outlet Structure.

From the part browser, you can specify the part type by right-clicking on an item under Part Configuration
and choosing Edit. The list of predefined part types is displayed.

Part Subtype Lets you organize parts into more detailed, logical groupings. This grouping does not affect
the part behavior. In the part browser, you specify the part subtype from the list of predefined subtypes.
You can also enter a custom part subtype if you wish. The part subtype is helpful during part selection to
filter a large group of parts that are of a similar type. In the illustration above, the part subtype is Undefined.
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Part Modeling

Modeling a part involves configuring a variety of part features.

In Part Builder, the term model refers to the graphical representation of a part. A model consists of various
features that have specific relationships to each other and that define the behavior of the part. Some features
require that you create simple shapes or points, while others require an extrusion or path. Some features
represent visible geometry, and some help you to position geometry precisely on a part. You can modify
features to refine and improve your parts over time. You change features by modifying their size and shape
or by flipping or moving them. To effectively model a part, it is important to understand how each feature
relates to the other features of modeling.

The following illustration shows the features that make up the model. Arrows indicate the direction of the
relationship between features. For example, modifying geometry affects a profile, which affects a modifier,
and so on.

wiork plane work plane
reference
: ,
[ge-::- ety ] constraints ]
[pr-::-file ] [ dimension ]
[ model
pararmet er

rodifier =R
dimenzion

The following sections introduce the features of modeling. Refer to this illustration as you learn more about
each feature to help you understand the relationships between features.

Work Planes Overview

Use work planes to define a part, position geometry, and define relationships between part features.

In Part Builder, a work plane is a modeling feature that defines the location of a plane in three-dimensional
(3D) space. It is an infinite construction plane that can be placed at any orientation in space. It can be offset
from an existing work plane, or it can reference 3D geometry. Using a work plane, you define the geometry,
dimensions, constraints, and profiles that make up the part model. Work planes help you to place geometry
that would otherwise be difficult to position. By constraining geometry to work planes, you can control
their location. Work planes help you to define relationships between features and provide control when
placing features.
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A work plane is displayed as a rectangular two-dimensional (2D) object. The work plane display is only a
visual representation of the infinite plane and cannot be moved or resized. However, you can control its
visibility for ease of viewing the model. Offset and reference work planes are user-defined and provide the
flexibility to be moved and redefined.

NOTE To ensure a manageable model size, it is recommended to use a minimum number of work planes.

When you right-click on a work plane in the part browser, it is highlighted in the modeling area. You can
change the view direction to match that of the selected work plane when adding geometry or dimensions
by using the Set View option on the Work Plane shortcut menu.

IMPORTANT Any features attached to a work plane are restricted to the original plane. If you move a work plane,
any features attached to the plane also move. If you delete a work plane, any features attached to the plane are
also deleted. Each feature attached to a work plane appears under the Work Plane folder in the part browser.

Part Builder provides three default work planes that intersect at the origin of the X, Y, and Z axes. The default
work planes help you to get started with modeling a part. Generally, it is best to start your modeling in the
top work plane, and add others as needed. You can add work planes at any time during the modeling process.
Each work plane has its own internal coordinate system. Work planes can be created on any plane in the
current user coordinate system (UCS) or in the World Coordinate System (WCS).

The following preset work planes can be added to a model from the Create Work Plane dialog box:

Default Creates the standard ZX, YZ, and XY work planes of the WCS.

Custom Creates a work plane that is not available by the preset work planes. The work plane has user-defined
values for the X and Y direction and the origin of the plane in the current UCS.

Offset Creates a work plane that is offset by a specified distance from a selected source work plane. For more
information, see Offset and Reference Work Planes (page 1086).

Reference Creates a work plane that is attached to the extents of a modifier feature. For more information,
see Offset and Reference Work Planes (page 1086).

Top Creates a work plane that matches the standard Top 3D view.
Bottom Creates a work plane that matches the standard Bottom 3D view.
Front Creates a work plane that matches the standard Front 3D view.
Back Creates a work plane that matches the standard Back 3D view.

Left Creates a work plane that matches the standard Left 3D view.

Right Creates a work plane that matches the standard Right 3D view.

Viewing default work planes

1 P P
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ZX work plane YZ work plane XY wark plane
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Offset and Reference Work Planes

Offset and reference work planes are relational and are based on one or more defined features in the model,
such as other work planes or modifiers.

Offset Work Planes

An offset work plane is a specified distance away from another work plane. This work plane can be offset
from any existing work plane, including another offset or reference work plane. You define an offset work
plane by selecting a source work plane and specifying a distance between the work planes. You can use offset
work planes to maintain specified or calculated distances between features, such as profiles, geometry, or
modifiers. You can also use offset work planes as construction guides for locating features that would otherwise
be difficult to locate. For example, use an offset work plane to define the length of a transition.

Creating an offset work plane

source work plane

offset work plane

specify offset
distance

Reference Work Planes

A reference work plane is defined as a plane on the face of the extents of a modifier. Every modifier has an
invisible extent, or boundary box, that defines the extents of the feature. You can create a work plane that
references one of the planes of the extent. To define a reference work plane, you select a modifier and a
source work plane that represents the plane direction you want to create. The extents, or boundary box, of
the feature is detected, and two valid reference work planes are available for selection. If the modifier is
moved or resized, the reference work plane is moved with it.

Creating a reference work plane

source waork plane

extents bow —

-

| »—reference woark
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Geometry

Geometry features are the basic building blocks for defining the size and shape of the model.

In Part Builder, geometry that you define is constraint based, two-dimensional (2D), and must be attached
to a work plane. You can switch between work planes to define different geometry. As you add geometry to
a work plane, the geometry features appear under the Geometry folder of the associated work plane.

WARNING Avoid using basic AutoCAD geometry commands. AutoCAD geometry is not valid for work planes
and cannot be used to create features for part models.

Viewing geometry types
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Part Builder provides nine types of geometry you can use to build the model:
Point Defined by an X and Y coordinate.
Line Defined by a position and a direction; constrained by a start point and endpoint.

Unbounded Line Defined by a position and a direction; infinite in length because it has no constraining
start point or endpoint.

Circle Defined by a center point and a radius.
Arc Defined by a center point and a radius; constrained by a start point and endpoint.

Rectangle Defined by lines and points that are constrained to maintain start points and endpoints for each
side and perpendicular angle.

Oval Defined by lines, arc, and points that are constrained to create two arcs tangent to two lines, with
defined start points and endpoints.

Point Reference Defined by a point in the work plane that is based on a source point selected from a different
work plane. A point reference is moved or deleted with the source point.

Project Geometry Defined by a projection of a modifier on a specified work plane. The project geometry is
fixed and cannot be moved in the work plane. It is linked to the modifier and adjusts as the modifier changes.
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Dimensions

Add dimension information to specify the length, diameter, or rotation angle of geometric elements in the
model.

Models require dimension information to define the size and position for the design. Dimensions are typically
added after you have finalized the geometric features of the model; however, you can add dimensions at
any time during the creation process. When you add dimensions, you apply rules that control the size and
position of features in the model. Dimensions work in conjunction with constraints. The model is updated
when changes are made to the dimensions.

Dimensions specify the length, diameter, or rotation angle of geometric elements in the model. When a
dimension is added, a corresponding size parameter is also added. This parameter creates a placeholder value
for the dimension that provides flexibility for defining the values of dimensions. Dimensions can be defined
as default numeric constants or as equations. Although you can use them interchangeably, they each have
specific uses.

B Numeric constants are useful when a geometric element has a static or fixed size that is populated as a
value in a basic table, list, or constant storage type.

B Equations are useful when the size of a feature icon must be mathematically defined relative to the size
of another feature.

Part Builder assigns a variable name to each dimension parameter. Letters and numbers are used to signify
the type of dimension (such as length or diameter) and the sequence in which the dimension was added to
the model (1 for first, 2 for second, and so on). To keep the model shape from becoming distorted as the
dimensions resize it, define the large dimensions first. Dimension type depends on the feature you choose
and where you place the dimensions.

NOTE When adding dimensions it is recommended to select points to specify the start and end locations. It is
also helpful to turn off geometry that you not dimensioning for ease of selection.

Viewing dimension types
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Part Builder provides seven types of dimensions you can add to the model:
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Distance Can be defined for pairs of geometry of all types. Defines a value between two features. The value
of a distance dimension cannot be negative. When adding distance dimensions between two lines, it is
implied that the lines are parallel with a given separation.

Horizontal Distance Can be defined for pairs of geometry of all types. Defines a value between two features
in a horizontal direction. The value of a distance dimension cannot be negative.

Vertical Distance Can be defined for pairs of geometry of all types. Defines a value between two features
in a vertical direction. The value of a distance dimension cannot be negative.

Parallel Distance Can be defined for pairs of geometry of all types. Defines a value between two features in
a parallel direction. The value of a distance dimension cannot be negative.

Perpendicular Distance Can be defined for pairs of geometry of all types. Defines a value between two
features in a perpendicular direction. The value of a distance dimension cannot be negative.

Diameter Can be defined for circular and arc geometry. Defines a value for the diameter of a circular feature.

Angle Can be defined for pairs of linear geometry. Defines a value for the degrees between two linear features.

Constraints

Add constraints to create rules that control how a part can change in shape or size.

Depending on the geometry of the model, you may need to add one or more constraints to define the shape
or size of the model. Constraints enforce rules that you want the model to obey. Constraining a model
controls how a model can change in shape or size, called “degrees of freedom.” For example, a circle has
two degrees of freedom: the location of its center and its diameter. If the center and diameter are defined,
the circle is fully constrained and those values can be maintained. Constraints specify the relationships of
geometric features; for example, whether two features are perpendicular, parallel, tangent, concentric, or
have the same midpoint or radius.

NOTE After you add geometry, dimensions, or constraints to the model, the degrees of freedom are listed on the
command line.

Constraints work in conjunction with dimensions to control the shape and size of the model. Any time you
modify the model, the geometry retains the relationships among features in accordance with the applied
constraints. You add constraints to indicate your design intent. For example, a parallel constraint could be
defined between two lines based on the geometry of the model. You could also add a constraint to force
both lines to have the same length.

As you apply geometric constraints, continue to analyze the model, reviewing and replacing constraints as
necessary. As you gain experience, you will be able to determine which constraints control the model to
meet your design requirements. Some constraints work only with lines, while others work only with arcs,
circles, or points.

See Adding a Constraint (page 1110) for step by step instructions on how to add a constraint.
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Applying a tangent constraint
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Applying a perpendicular constraint
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Applying a concentric constraint
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Part Builder provides ten geometric constraints. The following list describes these constraints and the features
with which they can be used.

Tangent Can be defined between curved geometry (such as a circle or arc) and either another curved geometry
or a line. Makes two curves tangential to one another, even if they do not physically share a point. Tangency
is commonly used to constrain a line to an arc or circle.

Parallel Can be defined between pairs of geometry with a direction, such as lines. Causes two or more lines
to be parallel to one another.

Perpendicular Can be defined between pairs of geometry with a direction, such as lines. Causes selected
lines to lie at right angles to one another.

Concentric Can be defined for any combination of circles and points. Fixes the centers of the geometry to
the same location. Common uses include circle to circle, where the center of both circles is the same; circle
to point, where the point lies at the center of the circle; and point to point, where the points are the same.

Coincident Can be defined between a point and any geometry. Fixes two points (including center points)
together; essentially, the point lies on the geometry.

Equal Distance Can be defined between two pairs of geometry. The distance between the first pair of
geometries is fixed to the distance between the second pair. Equal distance constraints do not control the
actual distance. Each pair of geometries must be one of the following: any combination of points and lines,
two circles or arcs concentrically constrained, or a point and circle or arc concentrically constrained.

Equal Radius Can be defined between two circles or two arcs. Fixes the radius of both circles or arcs to be
of the same value. Equal radius constraints do not control the value of the radii.

Midpoint Can be defined between a point and either two other points or two lines. The point is equal
distance from the other two geometries. Midpoint constraints do not control the distance. A common use
is constraining a point to the middle of a line.

Symmetric Can be defined between two geometries of the same type and a line. The two geometries are
symmetrically arranged on opposite sides of the line. The symmetric constraint does not force constrained
geometry to maintain an exact mirror image.

Normal Can be defined between a line or curve and a curve. (Two lines cannot be made normal; a
perpendicular constraint must be used instead.) The curves intersect and the directions of curve tangents
are perpendicular at the point of intersection. A common use is constraining a line to the normal of an
ellipse.
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Profiles

Create profiles to define a two-dimensional (2D) outline of a part’s geometric shape.

Using Part Builder, creating a profile is as easy as drawing a closed shape. Profiles are similar to geometry in
that they are a visual representation of the 2D shapes that make up the model. Because profiles automatically
associate constraints to the geometry, you can use profiles as a source of information from which to create
features. You create profiles on a work plane and apply modifiers, such as extrusions, to them.

NOTE Profiles can be used to create solids using modifiers. Non-profile geometry cannot be used to create solids
directly. However, you can group a set of non-profile geometries together to create a custom profile.

Part Builder provides four types of profiles to use for creating features in the model:
Circular Creates a profile based on a circle defined by a center point and diameter to maintain its shape.

Rectangular Creates a profile based on a rectangle defined by four lines, four points, and four perpendicular
constraints to maintain its shape.

Oval Creates a profile based on an oval defined by two lines, two arcs, four points, and four tangent
constraints to maintain its shape.

Custom Creates a profile from existing geometry in the model. The geometry must be attached to a single
work plane. Constraints are assigned as needed to maintain the shape of the geometry as it was selected.

Modifiers

Use modifers to create 3-dimensional features of the model.

A modifier is a general term for any operation that affects features of the model. After creating profiles, you
can use modifiers to extrude, add, or subtract features and to sweep a profile along a path. You can also use
modifiers to create cut planes and transition features.

Part Builder provides six types of modifiers: extrusion, path, transition, cut plane, Boolean add, and Boolean
subtract. The extrusion modifier is the most common type used in part modeling and is generally the base
feature for a model. When you extrude a profile to create a feature, you specify how the feature will modify
the shape by choosing one of four operations: midplane, plane, from-to, or blind.

See Applying a Modifier (page 1110) for step by step instructions on how to apply a modifer.

Midplane Extrusion Modifier

A midplane extrusion uses a profile as the center of the extrusion and sweeps the profile an equal distance
away from each side of the center.
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Applying a midplane extrusion modifier
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172 distance
9 1012 distance
celect profile specify distance

Plane Extrusion Modifier

A plane extrusion sweeps a profile between the profile itself and a specified work plane. If the work plane is
a reference work plane, the extrusion is updated when the work plane is moved.

Applying a plane extrusion modifier

top
Wik
&« lane
hottom
weark plane
select profile select work resulting
plane extrusion
rmodifier

From-To Extrusion Modifier

A from-to extrusion sweeps a profile between two work planes.
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Applying a from-to extrusion modifier

reference
wark
~—plane
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Blind Extrusion Modifier

A blind extrusion sweeps a profile a specified distance along its normal, or perpendicular axis. You can flip
the extrusion to sweep the profile in the opposite direction as the default normal.

Applying a blind extrusion modifier

top
WOk
- Plane
g

select profile specify distance flipped extrusion
rmodifier

&
0

Path Modifier

A path modifier sweeps a profile along path geometry. It creates a 3D feature based on the start and end
profile of a piece of geometry, such as a line or an arc. The start and end profiles can be different.
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Applying a path modifier

top
Wk
plane

<> > & >
ﬁf ﬁ

select path select start profile

o> <S>
ﬁ

select end profile resulting path
rmodifier

You can also specify the number of segments to use to create a 3D feature.

Transition Modifier

A transition modifier creates a transition body between two profiles. A transition includes both a start and
end profile, which cannot be in the same work plane. Point references are useful to ensure that the profiles
align between work planes; however, the centers do not need to align.

Applying a transition modifier

top
wWor
4 hlane
hottom
wdrk plane
select start select end resulting
profile profile transition

moadifier
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Cut Plane Modifier

A cut plane modifier cuts a feature into two parts, only one of which is kept. A cut plane modifier enables
you to change the end of a feature to a slope, providing for the creation of more advanced features, such as
an exhaust vent. You can modify the cut plane by dragging the normal, or perpendicular axis, of the modifier
to create custom slopes. Cut planes are updated when the length of the modifier changes.

NOTE Cut planes cannot be defined parametrically. How they are defined in the model is how they will be
displayed when placed in your drawing.

Applying a cut plane modifier
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select object specify cut plane
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Boolean Add Modifier

A Boolean add modifier combines two features to create a single feature. This modifier assumes a basic
concept of addition: that geometry inside other geometry, when added together, is removed. This modifier
is helpful when creating models of parts that are placed in your drawing exactly as they were created in the
model.
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Applying a Boolean add modifier

& &) &

select first object select second resulting Boolean
object addition modifier

Boolean Subtract Modifier

A Boolean subtract modifier subtracts one or more features from another to create a new feature. The Boolean
subtract modifier uses a basic formula when creating the resulting feature: that the subtractor objects are
removed from the base object. To see results in the model, the subtractor features must intersect with the
base feature. When no intersection of features exists, the subtractor features are removed from the base
feature with no visible change in the model.

Applying a Boolean subtract modifier

¢ &8 I8

select base object select subtractar resulting Boalean
ohject subtraction modifier

Placement Points

Use the Autolayout Data option to define the part placement point in the drawing.

After finalizing the part model, you need to define the placement point for the part to ensure that it can be
placed correctly in a drawing. The Autolayout Data option in the part browser controls how placement
points can be defined. When you enable this option, an Autolayout Data folder is available in the part
browser that includes commands for adding placement points.

This is done by selecting a fixed point in the model. This point must be in the z = O plane. By choosing a
fixed point, the parametric model will retain this position as it is dynamically sized.
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The placement point is the insertion point used to place the part in a drawing. You simply specify a point
in your model for the placement point.

Model Parameters

Configuring model parameters let you control the model’s overall shape and size by establishing relationships
between defined parameters.

As you add dimensions and constraints to the model, parameters appear under the Model Parameters folder
in the part browser. The Model Parameters dialog box provides a central location where you can view, create,
and edit the dimensional parameters of the model. You can define parameters to create additional model
relationships later.

It is often more efficient to assign numeric values to dimensions and other feature parameters as you build
the model. When you finalize the geometry, you can edit the model parameters to add calculated values.

An equation assistant is available in the Model Parameters dialog box to ensure that the equation you create
is valid and can produce a result. Each parameter in the Model Parameters dialog box includes the following:

Name A unique identifier for the model parameter. Model parameters are assigned default names, such as
LenB1, (Length Body 1), WTh (Wall Thickness), PID (Pipe Inner Diameter), and BdyD1 (Body DImension
1), that can be changed. Model Parameter names are typically short acronyms because they can be used in
equations. User-defined parameters must have unique names.

Value The result of evaluating the equation.

Equation The mathematical expression that defines the value of the parameter. Constants, other model
and user-defined parameters, and mathematical operators can be used in an equation. You can use the
Equation Assistant to define the equation.

Description A narrative, user-defined description of the parameter.
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NOTE When using a constant value in an equation, be sure to define the constant as a model parameter. You
should verify that the result of the equation is non-zero to avoid undesirable results in your model.

Size Parameters

Part sizes are controlled by size parameters that set the dimensions of the part size.

Model parameters define the default part size of the model, and act as placeholders for new values that can
be specified at a later time. There is a direct connection between the model parameters and size parameters
in that each model parameter is added to the size parameters in the part browser. Size parameters enable
you to create different sizes for the model to represent multiple part sizes and to add non-graphical parameters
to the part family.

You work with size parameters in the Edit Part Sizes dialog box. This dialog box lets you view and edit
parameter values and configuration attributes in a table. Each parameter is viewed or modified independently
of the others, so you can modify a single parameter at a time without scrolling through a large table.

The Edit Part Sizes dialog box has three working modes: Calculations, Parameter Configuration, and Values.
B The Calculations mode provides access to the calculation formula of the parameter.

B The Parameter Configuration mode provides access to attributes of the parameters, and includes
description, data storage, data type, units, visibility, context, and index.

NOTE When parameters are added to the model, the name, data storage, context, and type attributes are
assigned, and they cannot be changed.

B The Values mode provides access to defined values of the parameter when they are stored as constants,
lists, and tables.

NOTE Any calculations set in the model are fixed and can be changed only in the model.

The parameter configuration allows you to configure data storage. The type of data storage lets you define
the parameter as a list or table of values, in addition to a constant or calculated value. You can also revise
the parameter description and control parameter visibility. For more information, see Adding Individual
Part Sizes (page 1106). You can define constant values, and copy and paste lists of values from other parts to
define multiple part sizes. Calculated values can only be viewed. Use the Model Parameters dialog box to
modify formulas for calculated values.

By creating a new parameter, you can define values that store additional information about the part. You
can add custom parameters in which you define all parameter attributes, such as data storage type. You can
also add parameters by selecting from a list of optional parameters that have been defined for you. The list
of predefined parameters is determined by the part type and existing parameters found in the part family.
These parameters provide additional part information that can help to identify parts in your drawing during
the design process or when you produce a set of construction documents.
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Creating Parts with Part
Builder

This section provides step-by-step procedures, illustrations, and tips for creating | In this chapter

pipe network content using Part Builder. Tips for Creating Parts

Creating a Part
In Autodesk® Civil 3D, content is used to represent real-world pipe network parts Testing Parts

Modifying Parts

such as pipes, manholes, catch basins, and headwalls. Pipe shapes are organized
into the following part family categories based on the shape of the pipe: circular,
egg-shaped, elliptical, or rectangular pipes. Structure shapes, such as manholes,
catch basins, and headwalls, are organized into the following categories, or part
families, based on shape characteristics: general structures, inlet-outlet structures
(headwalls), junction structures (catch basins). Part Builder enables you to create

and modify part families as well as individual parts.
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Tips for Creating Parts

Make sure you understand these tips before modeling parts with Part Builder.

Tips for Using Part Builder

Keep the following tips in mind as you use Part Builder:

Save a backup copy of the part catalogs before using Part Builder, in case you need to revert to the original
catalogs provided with AutoCAD Civil 3D. You can use a browser application, such as Windows® Explorer,
to copy and paste the catalogs and their sub-folders to a new location.

Determine model dependencies. Analyze the model design to determine how features interrelate; then
decide how to create the model.

Work in a three-dimensional (3D) view. Creating the model in a two-dimensional (2D) view may lead
to confusion.

Start any new model in the top work plane and pick your fixed insertion position before modeling.
Use the order of the folders in the part browser as a guide to the steps involved in the creation process.
Do not use the EXPLODE command. Exploding a part deletes the part definition from the catalog.

Part Builder generates drawing views of your pipe network part. The AutoCAD MVIEW command does
not create associative views of your parts.

AutoCAD object snaps can be used to assist in object selection.

Tips for Modeling the Part

Keep the following tips in mind as you model the part:

Use work planes to control the UCS orientation. Using the AutoCAD UCS command does not associate
the current plane with your part.

Use the AutoCAD Point Style command to increase point sizes. It is recommended to use an absolute
point size.

Use a minimum number of points. Reusing points is less confusing and helps in constraining the model.

Use both constraints and dimensions. Some constraint combinations may distort unconstrained features
of the model. If so, delete the last constraint and consider using a dimension or a different constraint
combination.

Use Part Builder dimensions. AutoCAD dimensions are not parametric and therefore cannot control the
size, shape, or position of part content.

Dimension large features before small features. To minimize distortion, define larger features that have
an overall bearing on the model. Dimensioning small features first may restrict overall size. Delete or
undo a dimension if the model shape is distorted.

Define shape before size. If you apply constraints before dimensions, your model shape is less likely to
become distorted.

Determine model dependencies before applying constraints. A single constraint can often be used to
define more than one feature’s shape. Therefore, analyze the model design to help identify necessary
constraints.

Add constraints as needed to define the model shape. Because constraints often restrict more than one
feature, use fewer constraints to avoid distorted models.
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B When using calculated values for model parameters, be aware that calculated values are not available in
the part Add Size dialog box.

Creating a Part

This section contains step-by-step instructions for creating a simple part using Part Builder.

Each section describes a separate phase in the creation process. You should perform the steps in the order
in which they are presented to avoid creating unusable parts.

Creating a New Part

Use this procedure to start Part Builder and to begin creating a new part.

1 On the command line, enter PartBuilder, or click Pipes menu » Part Builder.

The Getting Started - Catalog Screen dialog box is displayed.

2 Select the Structure part catalog by selecting Structure from the Part Catalog list at the top of this dialog
box.

3 Select the Simple Shapes folder, then click New Parametric Part

The New Part dialog box is displayed.
4 Enter a name for this new part family. For example, enter Simple Cylinder 2.

5 Click in the Description field.

By default, when you click in the Description field, the description is the same as the part name until
you change it. You can type over this text to change it or add to it.

6 Click OK to create the new, undefined part family.
The new part family is displayed in the part browser window.

7 Proceed to Specifying the Part Configuration (page 1103).

Specifying the Part Configuration

Use this procedure to specify the part configuration, defining certain behavior of the new part family you
just created (Simple Cylinder 2).

1 In the part browser, expand Part Configuration.

2 To specify the part type, right-click Undefined Part Type, click Edit, and select a part type, such as
General Structure.

The predefined part types are dependent on the selected part domain. For example, for a pipe part, the
only available part type choice is “Pipe”. For structure shapes, which are more complex than pipe shapes,
there are multiple part type choices, such as general, inlet-outlet structures, junctions structures, and
so on.

3 To specify the part subtype, right-click Undefined Bounded Shape, click Edit, and select Cylinder.
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The list of predefined subtypes depends on the selected type. For example for pipes, choices are arched,
circular, egg-shaped, elliptical, rectangular, and undefined shape. For structures, you can specify the
following subtypes for undefined bounded shapes: box, cylinder, sphere, and undefined.

If desired, you can also enter a new subtype.

Proceed to Modeling a Part (page 1104).

Modeling a Part

To model a part, you must first define work planes on which to create the geometry of your model.

You can then create profiles and apply modifiers to define the shape and default size of the part. To avoid
distortion in the model, start with the larger features, which have more impact on the overall size of the
part, and then add the smaller features.

Establishing Work Planes

Use this procedure to add work planes on which to create the geometry of the model.

To avoid confusion, work with only one work plane visible, unless you are using offset or reference work
planes.

1
2

In the part browser, expand Modeling.

Right-click Work Planes and click Add Work Plane.
The Create Work Plane dialog box is displayed.

Click Top and then click OK.

The top work plane is created.

You can add other types of work planes as needed. For more information, see Work Planes Overview
(page 1084).

To view the work planes in the modeling area, on the View menu, click 3D Views » SW Isometric.

You can select any view direction or use the Views toolbar to zoom extents of your work planes.

In the part browser, expand the Work Planes folder.

When you select a work plane in the part browser, the work plane is highlighted in the modeling area.

Add more work planes as necessary to model the shape.

To avoid confusion, work with only one work plane visible at a time. To make only one work plane
visible at a time, in the part browser, right-click a work plane and remove the check from the Visible
check box (uncheck it).

When a workplane is marked as unvisible, the workplane icon in the part browser is grayed out, and
the work plane itself is not displayed in the modeling area.

Modeling a New Part

Use this procedure to model the new part you are adding.

Modeling any part typically involves adding a profile, geometry, dimensions, and constraints. You may need
to add extrusions, but these are typically used for more complex structure shapes.
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For a simple cylindrical structure part, the profile is circular, the geometry is typically fixed center, and an
example of a constraint is concentric. Dimension parameters are define various diameters for the shape. For
example, a dimension parameter named BdyD1 is used to define the diameter for the body of a simple
cylindrical structure.

1 To create the new cylindrical structure, in the part browser, right-click XY Plane and click Add
Profile » Circular.
For more information about profiles, see Profiles (page 1092).

2 Select a center point in the modeling area and specify a second point, or enter a value such as 12, to
define the cyclindrical shape radius.

A circular profile is created and is added to XY Plane in the part browser.

3 The next step is to add model dimensions to the part. Proceed to Adding Model Dimensions (page 1105).

For some shapes, you may want to add constraints or extrusion modifiers. For more information, see
Constraints and Modifiers in Understanding Part Builder.

Adding Model Dimensions
Use this procedure to add dimensions to specify the overall default size of the model.

Dimensions are used to define the default size of a part family (or part within a part family). You can add
other sizes, such as a list of values, to create individual part sizes within a part family.
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TIP You may find it easier to add model dimensions in the top view, rather than in a model view direction. To
change the view, on the View menu, click 3D Views » Top.

1 To define the overall length of the part, in the part browser, right-click Model Dimensions, and then
click Add Distance.

NOTE For constant parameter values, you can define a constant dimension, or choose not to add a dimension
and use the default value based on the actual size of the geometry. When no dimensions are added, the
parameter and its value are not displayed during part size selection.

2 Select the model modifier feature in the modeling area, and specify a location to place the dimension.
A length dimension (for example, LenB1 or LenB2) is placed in the model and is added to Model
Parameters and Size Parameters in the part browser.

3 To modify the default, or to specify a calculated value for the length of the component, in the part
browser, expand Model Parameters, right-click a length dimension, and click Edit.

The Model Parameters dialog box is displayed.

4 Double-click the Equation column value for a model parameter (such as LenB1), and you can enter a
value or an equation to specify the length of the part.

TIP Click Calculator to access the Equation Assistant.

Marne Value Equation Description Mew, .
BdyD1 24,0000 24 Body Diameter 1

FTh 2.0000 2 Floor Thickness
LenB1 60,0000 60 Cylinder Body Height
LenB2 60,0000 &0 30 Distance 2
LenB3 60.0000 60 3D Distance 3

SBSD 24,0000 24 Struckure Diameter

SBSH_ 2.0000 2 Frame Cylinder Height

SFH 6,0000 [3 Vertical Pipe Clearance

SWPC_ 6.0000 [ vertical Pipe Clearance

wTh 6.0000 & Vertical Pipe Clearance

= Equation Assistant

BrlyD1
24

Result

{ | ) ‘ Variable | Evaluate |
el | o] o] o] 1] <]
P Y Y P e
Y e e

5|

5 The next step is to add individual part sizes to the model. Proceed to Adding Individual Part Sizes (page
1106)

Adding Individual Part Sizes

Use this procedure to add individual part sizes to the model.

You create individual part sizes by adding parameter values. Values can be a list or table of values, a constant
value, or a calculation.

You can also create unique part size names. Each part size name is generated using a calculation — a formatted
string of parameter values and text.
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The set of default size parameters that are available for each part differs depending on the part type. For
example, a structure part defined as a junction structure (part type = junction structure) has a certain set of
default size parameters that are appropriate for junction structures. Inlet-outlet structures (part type =
inlet-outlet structure) have a different set of default size parameters available. Pipe parts have yet another
set of available size parameters.

1 To add part sizes, in the part browser, right-click Size Parameters and click Edit Configuration.

The Edit Part Sizes dialog box is displayed, showing all of the currently available size parameters for the
selected part. For the Simple Cylindrical Structure part example, some default size parameters are Part
Size Name (PrtSN) and Structure Vertical Pipe Clearance (SVPC).

3 Edit Part Sizes . @
— 43
|j E Parameter Configuration adl
Attribute SWPC PrtSM
Descripkion ‘Wertical Pipe Clearance  Part Size Mame
Data Storage Constant Calculation
Data Type
Uniits inch
Visible True True
Context
Index
0K 1 [ Caricel ]

|

NOTE Calculated values set in the model cannot be edited in the Edit Part Sizes dialog box. To change these
values you must edit the model.

2 To add a list of available sizes for the part, change the data storage type of a size parameter to List.

3 Edit Part Sizes @
|j E Parameter Configuration V
Attribute SHEN SBSH SPC SHETh Prefs |
Description Headwall Base width _Structure Height  Vertical Pipe Clearance  Headwall Base Thickness  Par| _
Data Storage Lisk Range * | Constant Conskankt Call |
Data Type Calculation
Units inch Constant inch inch o
PR Lisk
£ | I Range >
Table
OK ] [ Cancel ]
|
3 In the toolbar, select Values from the list.
The parameter values are displayed.
3 Edit Part Sizes @
y b= || values V
El
SHEMW | SESH | SWPC | SHETh | Preshl | Lendl | Lendz | LenB1 | SESL | SESW
1 38,0000 [45.0000 |6.0000_|6.0000 |38 x 6...]6.0000 |38.0000 |48.0000 |35, 0000 |6.0000 |
Ok ] [ Cancel ]
|
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4 To add new sizes for the part, click a parameter value such as the LenB1 parameter, and click Edit on
the toolbar.

The Edit Values dialog box is displayed.

m
Ea =
@ * E m\n‘alues v Tﬂ,
=
SHEY |SBSH |svpc |SHBTh |PrtSN |LenA1 |LenA2 |LenBl |SBSL |sssw
(1 38,0000 [48.0000 |6.0000_|6.0000 |38 = 6...J5.0000 |38.0000 J45.0000 [38.0000 |5.0000 |
= Edit Values
Miniraurn:
12000000 [ o ][ concel
Range Maxirnurm:
A

500.000000

Default:
45,000000

Cancel

5 Click Add and enter a new size. When you are finished adding sizes, click OK.

TIP You can cut and paste values from other part families using standard Microsoft® Windows cut and paste
functionality (CTRL+C and CTRL+V). Open another part in Part Builder, select the size parameter you want
to copy, and then paste the selected values in the desired parameter of your part. You can also create a list
of values in Microsoft® Excel, select the list of values you want to add, and then paste the values in the desired
parameter of your part.

Now when you click in the size parameter value you edited (for example, LenB1) on the Edit Part Sizes
dialog box, the list of sizes you just added is displayed.
6 To specify a unique, calculated part size name, select Calculations from the toolbar list box.

The calculation strings associated with parameter values are displayed. For example, the calculation
formula for a Part Size Name (PrtSN) for a structure could be “SHBW x SHBTh x SBSH inch Concrete
Rectangular Headwall”. Or for a pipe, it could be FormatNumber($PID,0) + “ inch Concrete Pipe”.

7 Double-click the value cell of PrtSN.
The Calculation Assistant is displayed.
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P o

i Calculation Assistant

PrESM: Park Size MName
SHEW x SHETh x SB3H inch Concrete Rectangular Headwall YH

33 x 6 x 48 inch Concrete Reckangular Headwall WH

Insert Yariable

Mame Descripkion | Precision: -
CatID Catalog ID B 0.0 Ed
ChcTy Conkent Type

CussF Custom Sizing Flag __Insert
Der Drata Yersion

HPrtF Hide Part Flag B |

| endd R Width ]

(a4 l [ Zancel

8 Define the part size name with a calculated value:

Highlight the value in the PrtSN: Part Size Name text box and press DELETE to remove the text.
Select O for Precision.
Under Insert Variable, select a variable and click Insert.

Click the value of PrtSN:Part Size Name and enter the text you want to display in the Part Size Name
string. For example, enter inch Dia. Concrete Pipe to add that text to the part size name.

Under Insert Variable, select Ptype and click Insert.

Select PTyp and click Insert.

9 Click Evaluate; the calculation result is displayed.

10 Click OK.

The calculation value of PrtSN is updated with the valid string and, when selected, the result is displayed
in the status bar.

3 Edit Part Sizes =]
A f= Calculations v
|2 |

|S|‘S“|PrtSN |L|L..|LenBl ‘SESL ‘SBSW ‘

B wo oo | JFormE g I lf5BSH  §sHEw [$SHBTH

Calculation: 38 = 6 x 48 inch Concrete Rectangular Headwall YH

IMPORTANT The part size name is generated using VB (Visual Basic) Script’s FormatNumber function and
simple string substitutions. Correct syntax is crucial. Use the Calculator to ensure that the string is valid.

11 Click OK.

Adding Individual Part Sizes | 1109



Adding a Constraint

Use this procedure to add constraints to the model.

The procedure below uses the example of aligning the top and bottom faces of a rectangular shaped part.
For more information on constraints, see Constraints in Understanding Part Builder.

—

10

In the part browser, right-click XY Plane and click Add Geometry » Point.

In the modeling area, specify a point near the center of the top face rectangular profile and press Enter.
In the part browser, right-click XY Plane and click Add Constraints » Equal Distance.

In the modeling area, specify the pairs of geometric constraints.

For the first pair, select the point in the center of the top face, and then the lower-left edge of the top
face rectangular profile.

For the second pair, select the point in the center of the top face, and then the upper-right edge of the
top face rectangular profile.

The model of the top face is updated to the specified constraint.

Repeat steps 3 and 4 to constrain the upper-left and lower-right edges of the top face.
The model of the top face is updated to the specified constraint.

NOTE When adding constraints, you may be prompted that the geometry is unconstrained by a specific
number of dimensions. These prompts are for informational purposes only to assist you during the modeling
process. It is recommended that you add a minimum number of constraints to define the shape of the part
to avoid undesirable results.

To ensure the alignment of the top and bottom faces, in the part browser, right-click Bottom Face and
click Add Geometry » Point Reference.

Select the existing point in the center of the top face rectangular profile.

A reference point is added to the bottom face work plane.

Repeat steps 3 through 5 to constrain all four edges of the bottom face using the reference point in the
center of the bottom face.

The model of the bottom face is updated to the specified constraints.

Applying a Modifier

Use this procedure to apply modifiers to the model.

The procedure below uses the example of applying a transition modifier to the two rectangular shaped parts
described in Adding a Constraint. For more information on modifiers, see Modifiers in Understanding Part

Builder.
1 In the part browser, right-click Modifiers and click Add Transition.
2 In the modeling area, select the top face rectangular profile for the start profile; then select the bottom
face rectangular profile for the end profile.
A transitional box is created to represent the diffuser, and a transition modifier is added to Modifiers
in the part browser.
3 To add the lip of the diffuser, in the part browser, right-click Work Planes and click Add Work Plane.
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The Create Work Plane dialog box is displayed.
4 Click Offset, enter Lip Offset for Name, and click OK.

5 In the modeling area, select the XY plane as the reference work plane, drag the cursor above the XY
plane, and enter 1 for the offset distance.

The Lip Offset work plane is created.

6 In the part browser, expand Modifiers, right-click Transition Modifier, and click Visible.
The transition modifier display is turned off in the modeling area.

7 In the part browser, right-click Modifiers, click Add Extrusion, and select the top face rectangular profile.
The Extrusion Modifier dialog box is displayed.

8 Under Termination, select Plane for Type, select Lip Offset for To, and then click OK.

A box is created to represent the top lip of the diffuser, and an extrusion modifier is added to Modifiers
in the part browser.

9 To see the entire model of the part, in the part browser, right-click Transition Modifier and click Visible.

Generating a Preview Image of a Part

Use this procedure to generate a preview image of the part to help during part selection.

Part Builder generates the preview image based on a specified view direction. You can select from the ten
standard AutoCAD view directions to view the model (top, bottom, left, right, front, back, SW isometric, SE
isometric, NE isometric, and NW isometric).

1 To create a preview image, on the toolbar, click Generate Bitmap.
The Bitmap Preview dialog box is displayed.

2 Under Generate View, click a view direction for the preview image of the part.
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TIP As you select a view, the preview image window in the dialog box is updated. This enables you to view
all the available preview images for the part before selection.

You can also click Browse to navigate to and select a bitmap image. Predefined images must be 200 x
200 pixels saved with 256 colors.

3 Click OK.

Defining Part Insertion Position

Use the Part Builder Autolayout commands to define the placement point where a part is inserted into a
drawing.

NOTE It is helpful to clean up the appearance of the model before defining the placement point. To turn off all
work planes and the associated geometry, profiles, and dimensions on those work planes, in the part browser,
right-click each feature and click Visible.

1 On the Part Builder toolbar, click Options.
The Options dialog box is displayed.

2 Make sure the check box in the Value column for the Custom Sizing Flag property is unchecked, and
that the Hide Part Flag property is checked, then click OK.
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= Options

Property Walue | Description
¥ Custom Sizing Flag O This allows the creation of custom sizes that do not exist in the catalog
¥ Hide Part Flag O This specifies whether or not the part is suitable to be inserted in a drawing

[ Ok ] [ Cancel ]

In the part browser, Autolayout Data is added to Modeling, and trim length points are displayed on
the model in the modeling area.

3 Change the model view to plan view. On the View menu, click 3D Views » Plan View » World UCS.

4 In the part browser, expand Autolayout Data, right-click Layout Data and click Add Trim Length.

NOTE To ensure components are trimmed correctly when placing a part into a drawing, you must define
trim lengths for the part in a specific order—left to right, then bottom to top.

You are prompted to select the start and end of the trim length. Repeat this for the three trim lengths
required for auto layout of the part.

B Define the first trim length.
For the start of trim length 1, select the point at the center of the part. For the end of trim length
2, select the point at the left end of the part.

B Define the second trim length.
For the start of trim length 2, select the point at the center of the part. For the end of trim length
2, select the point at the right end of the part.

B Define the third trim length.
For the start of trim length 3, select the point at the top of the branch (the center of the part). For
the end of trim length 3, select the point at the bottom of the branch.

Trim length lines are displayed between the selected points.

5 In the part browser, right-click Layout Data and click Select Placement Point.

You are prompted to select a point on your model. This point is the location at which connecting
segments would intersect if they were extended along their logical paths. The placement point is used
as the insertion point for the part when it is added to a drawing during autolayout.

6 Select the trim length point at the center of the part.
A placement point is displayed at the selected location.

Validating and Saving a Part

Use this procedure to validate and save the part.

1 On the Part Builder toolbar, click Validate.

Upon successful completion of these procedures, the part is validated and the status bar is updated with
a message indicating if the part validation is successful.
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Part is valid

|

=
i s &
= [A AeccStructRectHeadwallvarHt_Imperial

Part Configuration
21 Modeling
ﬂ Size Parameters

Part Family validation successful | Details | oo

If you have errors in your model, the status bar message displays that the part validation failed, and a
dialog box is displayed listing the errors. Review the errors, make necessary modifications, and repeat
this step until validation is successful.

Part is invalid

=
i g &
= [A AsccStructRectHeadwallvarHt_Imperial
Part Configuration

=1 Madeling
ﬁ Size Parameters

_Park Family validation Failed | Details | $0

Resulting error dialog box when part is invalid
3 part Family Validation Results

15:55: ERROR: Part Type parameter not validated
15:55: Validation Summary -- Level 1 Errors Found

[i] T | m

Cleat I [ Close l

A

NOTE Warnings in the Part Family Validation Results dialog box do not make the part invalid.

2 Once validation is successful, on the toolbar, click Save Part Family or Save Part Family As.
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3 Specify whether to make the part available in the catalog.
B Click Yes to make the part available to users.

B Click No to keep the part hidden.

NOTE This prompt toggles the Hide Part option in the Options dialog box in Part Builder.

The part is saved in the specified catalog location.

4 C(lick Close on the File menu.

NOTE At this point, you are prompted to save changes to the drawing file <new part family name>.dwg. If
you saved the part family, you should also save this drawing file, so click Yes at this prompt. If you did not
save the part family, then you should click No at this prompt and not save this drawing file.

Testing Parts

The guidelines presented here will verify that your part sizes work correctly for your AutoCAD Civil 3D
drawings.

It is important to test each part size before using it in your drawings. You should verify the insertion point,
and all view representations. If testing produces undesirable results, you should modify and retest the
appropriate part sizes.

Testing the Display Representations

This section summarizes how to test the display representations of parts.

Depending on whether you test part sizes in a drawing started from scratch or from a template, you verify
accurate view representations in one of two ways: by scrolling through the various display configurations
in a viewport, or by scrolling through the various layout tabs in a template. You should see representations
on the Model tab similar to the following as you change display configurations for the viewport.

TIP To quickly change display configurations for a viewport, select a display configuration from the list in the
bottom-right corner below the drawing area.

Using Catalog Regen

Catalog Regen is a necessary step that runs through an entire part catalog and validates all parts.

You can run Catalog Regen by clicking the Catalog Regen button on the Getting Started - Catalog Screen
dialog box. Use this procedure to regenerate a part catalog that you have modified. Regenerating a part
catalog updates the APC file. A part catalog can be used inAutoCAD Civil 3D only if regeneration has been
completed.

To regenerate a part catalog

1 Verify that the part catalog you modified is the current catalog that is selected in the Part Catalog field
of the Getting Started - Catalog Screen dialog box.

For example, if you modified the pipe catalog, make sure Pipe is selected in the Part Catalog field. If
you modified the structure catalog, make sure Structure is selected in the Part Catalog field.
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On the Getting Started - Catalog Screen dialog box, select the top-level catalog folder in the tree view,
and then click the Catalog Regen button. This regenerates the selected part catalog and updates the
catalog to reflect new or deleted part sizes.

The Catalog Regen dialog box is displayed, showing the status of the regeneration process.
To verify that the part catalog has been regenerated and updated, open Windows Explorer.

Navigate to the part catalog location \Documents and Settings\All Users\Application
Data\Autodesk\C3D 2008\enu\Pipes Catalog\US Imperial Structures\Validate, and double-click the
Validate folder located in the same directory as the appropriate Autodesk part catalog (APC) file.

In the Validate folder, open Catalog_Regen_Summary.txt, and scroll through the file to verify that the
selected part sizes have been copied to, or deleted from, the part catalog.

Validating Parts in a Catalog

Use this procedure to validate parts you have changed or added to a part catalog.

Validating a part catalog steps through the catalog structure and verifies its parts. Remember that only valid
parts are available during part selection.

To validate parts in a part catalog

1

Verify that the appropriate part catalog is the current catalog that is selected in the Part Catalog field
of the Getting Started - Catalog Screen dialog box.

For example, if you want to validate the pipe catalog, make sure Pipe is selected in the Part Catalog
field. If you want to validate the structure catalog, make sure Structure is selected in the Part Catalog
field.

On the Part Builder Getting Started - Catalog Screen dialog box, click the Catalog Test button.

The Test Catalog feature steps through the catalog structure and validates part sizes by verifying that
necessary part size information exists for each part size. The Catalog Test dialog box is displayed, showing
the status of the testing process. When the catalog test is complete, an AutoCAD alert dialog box is
displayed, reporting the results of the test.

To verify that the part sizes in the part catalog have been validated, open Windows Explorer.

Navigate to the part catalog location \Documents and Settings\All Users\Application
Data\Autodesk\C3D 2008\enu\Pipes Catalog\US Imperial Structures\Validate, and double-click the
Validate folder located in the same directory as the appropriate Autodesk part catalog (APC) file.

In the Validate folder, open Catalog_Validation_Summary.txt, and scroll through the file to verify that
all the part sizes have been validated. If a part was not validated, an error notice in the file states which
information is missing for the part size.

Modifying Parts

This section summarizes how to modify existing parts using Part Builder.

For parts in the pipe network catalogs provided by AutoCAD Civil 3D, you can change the part behavior
and part size parameters. For parts you create using Part Builder, you can change the part behaviors, part
size parameters, and part model including geometry, profiles, modifiers, constraints, and dimensions. You
can also delete parts that you no longer need. Deleting parts can be helpful when creating custom catalogs
to ensure that all associated definition files are managed correctly.
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Starting Part Builder for Modifying a Part

Use this procedure to start Part Builder and modify a part.

1 In the command line, enter PartBuilder and press ENTER, or click Pipes menu » Part Builder.
The Getting Started - Catalog Screen dialog box is displayed.

2 In the part browser, navigate to and select a part.

3 To modify the part, click @ .

The existing part is opened in the parametric building environment.

*.

4 To delete a part, click

The selected part family is deleted from the part catalog, including all associated definition files (XML,
DWG, and BMP files).

Making Changes to a Part

As your design develops and parts change, you can modify parts using Part Builder. You can change the part
behavior and part size parameters. For parts you created using Part Builder, you can also change the part
model, including geometry, profiles, modifiers, constraints, and dimensions. You can use the same procedures
that guide you through creating a part to modify it. This section outlines how you can modify a part and
provides references to the related procedures that you can use to make changes.

IMPORTANT When making changes to a part, refer to the illustration in Part Modeling (page 1084). This illustration
shows the relationship dependencies between features that must be maintained to ensure you are creating a
usable part.

Modifying the Part Configuration

You can change the part configuration that controls the behavior of and defines the characteristics of the
part. In the part browser, expand Part Configuration and change the part type or subtype. For more
information, see Specifying the Part Configuration (page 1103).

Modifying the Part Model

For parts that you created using Part Builder, you can change the model parameters that define the overall
size of the model. You can change the geometry, dimensions, and constraints of the model.

You can add, modify, or remove geometry in the model; however, you must append the changed geometry
to the profile in order for Part Builder to update the model and assign new geometric constraints.

You can also change the parametric relationships of model elements by modifying the geometric and
dimension constraints. Because constraints control the overall shape of the model, you cannot safely make
changes until you know the current constraints applied to the model. You can delete an unwanted constraint
or add new constraints to reshape the sketch.

Part Builder’s parametric commands ensure that relationships among geometric elements remain intact;
however, after changes are made to the model you should re-examine the geometric constraints and
dimensions to verify that nothing else in the model needs to be updated.
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Modifying Part Sizes

You can change the model dimensions of the part that determine the overall size of the model, such as
length and width. You can also change individual size parameters for a specific part size. For example, you
can change a constant size parameter value to a list of values. For more information, see Adding Model
Dimensions (page 1105) and Adding Individual Part Sizes (page 1106).

Modifying the Preview Image or Part Insertion Behaviors

You can change the preview image by selecting a different view direction that Part Builder uses to generate
the preview image. For more information, see Generating a Preview Image of a Part (page 1111).

You can change the insertion configuration of the part that defines the placement point of a part in a
drawing. For more information, see Defining Part Insertion Position (page 1112).
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